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Figure 0.1 Location map, downtown Indianapolis, Indiana Figure 0.2 Key Plan, NCAA Headquarters

1. Walter Byers Auditorium
2. Palmer E. Pierce Room
3. Theodore Roosevelt Atrium
4. Chancellors and Presidents Room
5. James Frank Room
6. Judith M. Sweet Room
7. Directors Room
8. Faculty Room
9. Membership Room
10. Scholar-Athlete Room
11. Alumni Room
12. Varsity Room
13. Hall of Champions Great Hall
14. Partnership Plaza

        15.   Hall of Champions

NCAA Headquarters and
Hall of Champions

Map and Key Plan
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This study examines the qualitative and quantitative aspects
of the preset lighting conditions of the Walter Byers Audito-
rium at the National Collegiate Athletic Association (NCAA)
Headquarters in The White River State Park in Indianapolis.
The study compares seven preset lighting conditions in the
space.  Our team�s intent is to demonstrate whether or not
the space is �appropriately lit� for the seven different uses.
We acknowledge that in using a multitude of settings that it is
improbable that at each setting an optimum or ideal lighting
condition is attained; instead, we will seek to ascertain that
an appropriate compromise of seven different settings is
obtained.  The settings should be compromised so that the
integrity of the lighting scheme of each setting is not compro-
mised.

In each of the settings, our team inventoried the lighting of the
room.  Our team then developed a set of criteria to analyze
each setting and space.  We studied the qualitative aspects
of the lighting at each setting through this established crite-
ria.  We situated ourselves in multiple, designated places at
each setting, to examine these �immeasurable� qualities.  The
quantitative aspect of the lighting at each setting was exam-
ined through lighting measurements and visual field mapping.
These findings were then analyzed based, again, on the es-
tablished criteria.  The findings and analyses of each preset
setting were used to determine if the space at that particular
setting was �appropriately lit�.  Finally, those determinations
of each space were combined to determine if the whole light-
ing scheme, including each of the settings, was appropriate.

Abstract
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B. Garrett, F. Grunert, S. Karwan

Upon analysis of the auditorium space at each of the seven
settings, our team determined that the space is appropriately
lit.  Its multiple settings accommodate for a variety of func-
tions.  Each of the settings has only minor problems which do
not distract from the activities taking place within the space.
Finally, our report includes a list of recommendations our team
has developed.
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Vital Signs VI, a course offered by the College of Architec-
ture and Planning at Ball State University is administered by
the Center for Energy Research/Education/Service.  The
course works in conjunction with the national Vital Signs
Project established at the University of California, Berkley.
Vital Signs is focused on learning about building design
through the study of the performance of existing buildings.

The NCAA Headquarters and Hall of Champions, is part of
the White River State Park in Indianapolis Indiana (Figure
0.1).  Designed by Michael Graves, in partnership with
Schmidt Associates of Indianapolis.  It opened in 1999.  The
headquarters provides office space for approximately 400
workers, and provides 50,000 approximately +square feet of
exhibition space in the Hall of Champions.

The focus of this study was within the Headquarters building.
This four-story facility is highlighted by a southern full-height
entrance atrium.  The ground floor provides mostly multi-pur-
pose rooms and specialized spaces.  The upper three floors
are general office space, and all overlook the atrium.

The Walter Byers Auditorium is at the West end of the first
floor (See Figure 0.2).  Seating approximately 150 people, it
is used as a large meeting room, for press conferences, web
casting, event conferences, and lectures.  The auditorium is
48� 10� deep by 36�2� wide (See Plan, Figure 0.4).  The floor
is raked with stepped platforms front to back; each step con-
tains a row of seats.  The stage front is twenty-four inches
above the lower floor level.

The multiple functions of the space predicate that different
lighting conditions are used.  A LutronÒ lighting system con-
trols the lighting for the space and includes seven preset con-
ditions.  These include:

1. �Full Stage�
2. �Slide Projection�
3. �Video Conferencing�
4. �House Lights�
5. �Stage Left - Lecture�
6. �Stage Right � Lecture�
7. �Stage Center � Lecture�

An eighth setting, for cleaning and maintenance is utilized
sparingly, and was not studied.

The room is twenty-four feet tall above the finished floor at its
tallest point, at the front of the stage (See Section, Figure
0.5).  The floor steps higher, progressing to the back of the
room.  There are eight steps, each is eight inches in height
with a tread of forty-nine and a half inches.  A row of seating is
located along each step.  Each row seats fourteen people,
except for the first two rows.  The first row has permanent
seating for eight and space for six wheelchairs or temporary
seating.  The second row seats eight people.  Each row of
seats has a common, eighteen-inch deep work surface fin-
ished with a maple laminate.  Each row of seats parallels the
projecting curve of the stage.
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Introduction - Fixture Diagram and Inventory
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Fixture Type Description:

FA
The Darklite 30/5 is a 5-inch aperture downlight designed for use with
75 watt (maximum) PAR-30 spot or flood lamps.

FD
The Spredlite 38 PV/9 is an incandescent wallwasher that provides
uniform illumination on vertical surfaces.  The fixture is designed for
use with PAR-38, 150-watt (maximum) spot lamps.

FC
The Darklite 38/40/6AA is a 6 inch aperture adjustable accent light
designed for use with 250 watt (maximum), PAR-38 spot and flood
lamps.

FC-1
The Darklite 38/40/6AA is a 6 inch aperture adjustable accent light
designed for use with 250 watt (maximum), PAR-38 spot and flood
lamps.  (Angle mounted)

FK
The Bega 1140 120 is a recessed wall lamp that is designed to use a
20 watt, G4, 12 volt lamp.

FE
This lamp could not be identified as of yet due to a lack of shop
drawings.

Figure 0.3 Reflected ceiling plan diagram
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Figure 0.5 Section (from front  to back of auditorium)
Note: Not to scale

Figure 0.4 Room Plan
Note: Not to scale



�The Walter Byers Auditorium is appropriately lit for
seven different event uses.�

Our study tested the pre-set lighting control system of the
room.  An evaluation will be completed testing whether it is
appropriately used and preset, based on both qualitative and
quantitative criteria.  Our team assumed that due to the vari-
ety of settings that one setting alone would not be optimum.
Instead, a compromise between settings must be understood
so that the complete system becomes acceptable.

Hypothesis
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The study of the space was conducted in three phases: in-
dicative, investigative and diagnostic.  The indicative phase
consisted of a tour of the facility to gather general impres-
sions about the building related to lighting.  Later, information
and more in-depth impressions about the space were gath-
ered and an indicative study of the selected auditorium space
was completed.  During the investigative phase, measure-
ments and visual field mapping were completed, and data
were collected.  Qualitative aspects were also studied at this
time.  The diagnostic phase consisted of analyzing and re-
taking measurements (when necessary).  Our data of both
the qualitative and quantitative studies were compiled.

A list of criteria was developed to help define the term �ap-
propriately lit� as it pertains to the Walter Byers Auditorium.
The criteria consists of both qualitative and quantitative as-
pects and were developed into a matrix.  The categories used
to define �appropriately lit� include:

Comfortable/uncomfortable (the qualitative aspects)
-Issues of glare

(audience and stage)
-Worksurface glare
-Shadows
-Worksurface shadows
-Backlighting

-Color of lighting
-Lighting contrast

Adequate/inadequate (the quantitative aspects)
-Light levels (based on accepted design standards)
-General audience (ambient), stage, task
surface, etc.
-Footcandle levels
-Uniformity of lighting levels

Methodology
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When developing the criteria for the qualitative evaluation,
these issues were addressed.  If any of these issues became
detracting or inhibitive to the function of the space, they were
regarded as negative.  If the issues were not distracting, or
enhanced the function or quality of the space, they were re-
garded as positive.  A brief description of the positive and
negative aspects of each issue is as follows:

Glare:  Glare should provide not be uncomfortable viewing of onstage
activities.  General glare should not detract from presentation/lecture/
performance on stage.  Glare causes eyestrain: this is not appropriate.

Worksurface glare: Worksurfaces include audience worksurfaces and
stage lectern.  Worksurface glare should not disturb note taking, read-
ing, etc.  Worksurface glare should not inhibit the functions of the space.
Worksurface glare is not wanted.

Shadows: Shadows should enhance (i.e. by providing depth to) activi-
ties and presentations onstage.  Shadows should not inhibit views onstage
and should not detract from focal points.

Worksurface shadows: Worksurfaces include audience worksurfaces
and stage lectern.   Shadows should not detract from note taking, read-
ing, or any other activity that takes place at the worksurface.

Backlighting:  (Dealt with specifically at the stage).  Lighting should
highlight focal points.  Lighting should not detract from focal points.

Color of lighting:  Color should enhance or not distract from the func-
tions of the space.   Colors should not be distracting and should not
produce eyestrain.

Lighting contrast: Lighting contrast should not cause eyestrain.
Sharp contrast that is necessary for the function of the space (i.e.
slide projection) shall not become visually overbearing.

Methodology
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A first visit to the NCAA Headquarters provided us an oppor-
tunity to gather general impressions of the facility.  We paid
close attention to daylighting, task lighting, geometries of light,
etc.  It was during this initial visit that our team decided to
further investigate the lighting in the Walter Byers Auditorium.
We spent only a few minutes in this room during the initial
visit, but the uniqueness of the preset lighting of the room,
captured our interest.

During our second visit, our team�s focus was on the Walter
Byers Auditorium.  Because our study was still being devel-
oped, we had no particular focus.

As we entered the auditorium, we assessed the transition of
light from three key spaces: the atrium, the vestibule, and the
auditorium. Day-lighting primarily affects the atrium; electri-
cal lighting affects the vestibule and auditorium spaces.  Us-
ing our light measurement instruments we gathered data
showing that the atrium space received a significantly greater
amount of light on the given day compared to the auditorium
spaces.  (Later, we determined that this transition was not
significant enough to study.  A small closed vestibule space
allows for a comfortable progression.  The room is set to one
particular setting as the audience enters.  The transition is
not relevant to the other six settings, as there is no transition
between the lobby space and the auditorium space with these
settings.  Consequently, we decided not to study this further.)

Indicative Visit

While doing a brief walkthrough of the auditorium, we ob-
served the space during its seven different lighting settings.
We documented the usage of particular lamps and pattern-
ing within the space.

It was after this visit that we decided to study each preset
lighting condition and develop criteria by which we would
evaluate each setting.  We would then, as our study, evalu-
ate each setting, and the system as a whole.

Procedure-Indicative Study

Our team gathered preliminary information by recording read-
ings taken at designated points.  The majority of the data
collected were measured at the worksurface height of 30�.
Measurements in the seating and viewing area were taken
along every other row and at 9 points across the room.  The
measurements were broken down as follows; data collected
at both side walls, center of row, both ends of row and two
points between center and edge of the rows.

After data were gathered, photographs were taken from sev-
eral viewpoints to get the basic understanding of the space.
(More detailed pictures were taken during our later investi-
gative visits.)  Pictures were taken during the various presets
of the lighting and lighting changes were documented based
on lighting configurations and stage illuminations.

VITAL SIGNS VI: A Lighting Study of the Walter Byers Auditorium at the NCAA Headquarters, Indianapolis, Indiana
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Investigative

The investigative segment of this paper is split into seven
sections, each detailing one of the lighting conditions stud-
ied.  Our team�s findings related to each section will be de-
scribed here.

During our investigative visits to the NCAA Hall of Champi-
ons and Headquarters, our team focused primarily on data
collection.  These data consist of lighting measurements (mea-
sured in footcandles), and visual field mapping (using digital
images). Also during this phase, qualitative aspects of each
setting were observed and documented based upon the des-
ignated criteria.

First, our team set the lighting of the room to Setting One,
�Full Stage.�  While on this setting, we walked around the space
starting in the right rear corner.  We placed the light meter
(Sylvania electronic photometer) on the 30� work surface at
the center of every second seat, adjacent to an electrical/
data outlet.  In addition, light levels at three points of the stage,
center, right, and left (corresponding to the three locations of
the lectern) were measured.  While doing this we were con-
sistent in making sure that we were below the light meter so
that our readings were not disrupted.

After taking measurements in this manner for the entire eight
rows, we proceeded to take photographs of the actual light-
ing conditions.  To do so, we stood in the back center of the
space and photographed the stage conditions.  Photographs
were then taken of the ceiling condition at a single point at
the center of the fourth row.

The qualitative aspects of each lighting condition were
observed and documented during this phase.  During each
setting, we observed the space from different locations: the
center two seats of the fourth row, from the stage center
looking towards the audience, from the center seats of the
first row, and from the two end seats of the last row.  These
observations were then generalized into a set describing
each preset condition.

The visual field mapping was conducted using a very simple
technique.  Initially we photographed the auditorium during
all seven lighting stages, using a digital camera.  We then
took these digital images and manipulated them using Adobe
Photoshop so that they could be used as visual field maps
(see Appendix B).  We then used a physical copy of these
images to document luminance measurements during a later
site visit; we used a Minolta Luminance Meter LS-100 to col-
lect measurements of the actual visual field.  To gather the
measurements we initially stood in the center of the back row
of the auditorium and used the Luminance Meter to gather
what measurements we could capture within the Meter�s vi-
sual field.  We then moved up to the center of the fifth row and
took measurements.  Here we were able to collect the mea-
surements that were too small for the meter to focus in on
from the rear of the room.  We completed this process for
lighting Stages one through seven.

The measuring, collection and documentation of these data,
was repeated for each setting, and proceeded in the same
manner as described.

VITAL SIGNS VI: A Lighting Study of the Walter Byers Auditorium at the NCAA Headquarters, Indianapolis, Indiana
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Setting 1: Full Stage

Figure 1.1 Setting One:  Full Stage Fixture Status Diagram
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B. Garrett, F. Grunert, S. Karwan

This setting�s lighting design intent does not seem to be as
indicated.  Rather than allowing for full lighting of the stage, it
allows for the full lighting of the auditorium.  The lights above
the seating are all on, as is most of the lighting for the stage.
Floor lights, vestibule lights, and entry lights deem this set-
ting to be used for general usage.  It also is to be used prior
and after events, as it allows for the entry and exit of the large
group of people.  The plan diagram (Figure 1.1) indicates
each fixture status within the space.
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Setting 1: Full Stage

Figure 1.3  Visual field map, Setting One, Full Stage
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Figure 1.2 Setting One: Full Stage
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Setting 1: Full Stage

Qualitative observations

An analysis of the qualitative criteria indicates a few minor
problems.

Glare: Non-existent to minimal.  Change in light levels
from one surface to another is very subtle.  There are no
drastic changes for the eye.
Worksurface glare: Minimal glare due to matte plas-
tic laminate finish of worksurface.  Discomfort from glare
was minimal.  It was also considered that at this setting
the usage of the worksurfaces would be minimal, fur-
ther downplaying any problems.
Shadows: The few shadows at the stage were not dis-
tracting.  Instead, they served to add contrast to the
visual picture.  All possible focal points at the stage
were well lit.
Worksurface shadows: Worksurface shadows were
created by the placement of multiple fixtures overhead.
Because the light was fairly uniform, the shadows were
not distracting.  Again, the usage of the worksurface
would be minimal at this setting.
Backlighting: Backlighting was not a distracting factor
in this setting.
Lighting color: The �cool white� lamps of the coffered
ceiling provide a comfortable color.  These larger central
fixtures drowned the other canister lights of the coffered
ceiling out.  The stage lighting provides a necessary
coloration for the features onstage.
Lighting contrast: The levels of the seating and stage
areas were relatively similar.  The different coloration
provided an appropriate contrast indicating a hierarchy
within the space.
Overall Impression:  The space was comfortably lit.
The change of view from the worksurface to the stage
was comfortable.
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Setting 1: Full Stage

Quantitative observations

Lighting levels within this setting are indicated in Appendix
C.1.   A diagram (Figure 1.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 1.3) was completed at this setting.
It indicates that there are subtle differences in light levels
throughout the visual field, lighting is uniform throughout the
space, and allow for focus on task surface and general stage
applications.  The lighting levels range from 4.6fc (surround-
ing the slide projection screen) to 13.4fc (task surface areas/
general audience seating) and ranging from 41.6fc (lamp
output from stage spot lights) to 27.3fc (floor level of general
stage area).  There is an even amount of spread between the
various measurements that allow for the space to have effec-
tive lighting geometries.

VITAL SIGNS VI: A Lighting Study of the Walter Byers Auditorium at the NCAA Headquarters, Indianapolis, Indiana
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Setting 2: Slide Projection

This setting is used as indicated, for slide and video projec-
tions.  Dimmed general lighting allows for the screen to be
easily seen.  Sixteen fixtures hidden within a bulkhead at the
rear projection wall are all lit in this setting. The plan diagram
(Figure 2.1) indicates each fixture status within the space.

Figure 2.1 Setting Two: Slide Projection, Fixture Status Diagram
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Setting 2: Slide Projection
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Figure 2.3  Visual field map, Setting Two, Slide ProjectionFigure 2.2 Setting Two: Slide Projection
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Setting 2: Slide Projection

Qualitative criteria

An analysis of the qualitative criteria indicates few minor
problems.

Glare: Minimal (at lectern onstage) and not distracting.
Worksurface glare: As the worksurface is not used in
this dimmed setting, a study of this is not applicable.
Shadows: The absence of multiple competing light
sources mitigated the shadows.  Unnoticeable shadow
created by sloped bulkhead above stage.
Worksurface shadows: As the worksurface is not used
in this dimmed setting, a study of this is not applicable
Backlighting: Backlighting at the rear projection wall
provided necessary illuminance for the projected images.
Screen emitted additional lighting.
Lighting color: The dimmed �cool white� lamps of the
coffered ceiling provide a comfortable color within the
seating space.  The screen produced a comfortable,
whitish light.  The stage lighting, combined with the lami-
nate surfaces of the stage walls, produced a slightly
uncomfortable yellow light.
Lighting contrast: The spread in contrast between the
audience lighting and the stage lighting was severe  (the
transition of ones view from the stage to the worksurface
was uncomfortable, there was to much light on stage
as apposed to a lack of light on the audience).
Overall Impression:  The space was comfortably lit.
Only the transition of the view from the stage to the
worksurface needed improvement.
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Setting 2: Slide Projection

Quantitative criteria

Lighting levels within this setting are indicated in Appendix
C.2.   A diagram (Figure 2.4) depicts the general light levels
within the room. The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 2.3) was completed at this setting.
Its results indicate that the light levels are focused toward the
slide projection wall from the overall visual field.  Lighting lev-
els increase uniformly from general audience, task surface,
areas to stage and slide projection wall.  Lower levels of light-
ing range from 2.1fc (task surface areas) to 6.6fc (wall sur-
face area surrounding projection screen).  Higher levels of
lighting, stage lamping, indicate levels ranging from 41.4fc to
23.1fc.  The visual field map exemplifies the idea of a spot
light effect where the innermost portion of the visual field re-
flects the highest level of illumination.
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Setting 3: Video Conferencing

This setting allowed for web-casting and video conferencing
to be held within the space.  Most of the lights  (especially the
stage lighting) were dimmed to allow for the video equipment
necessary for the usages.  General seating lighting was
dimmed.   The plan diagram (Figure 3.1) indicates each fix-
ture status within the space.
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Figure 3.1 Setting Three: Video Conferencing, Fixture Status Diagram
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Setting 3: Video Conferencing
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Figure 3.3  Visual field map, Setting Three: Video ConferencingFigure 3.2 Setting Three: Video Conferencing
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Setting 3: Video Conferencing

Qualitative criteria

An analysis of the qualitative criteria indicates few minor prob-
lems.

Glare: Non-existent.  The setting�s usage makes this a
necessity; the issue was controlled adequately.
Worksurface glare: Glare is non-existent as the am-
bient seating lighting was dimmed.
Shadows: Minimal shadows (created by the stage bulk-
head) were virtually unnoticeable and highlighted fea-
tures onstage, providing an appropriate image.
Worksurface shadows: Worksurface shadows were
minimal due to the multiple overhead fixtures.  The stron-
gest shadows were created from stage lights flowing
into audience area.  These were not distracting.
Backlighting: Backlighting served to provide more uni-
form lighting within the space necessary for the video
equipment used in this setting.
Lighting color:  The stage lighting, combined with the
finishes of the stage walls produces an orange, dis-
tracting and uncomfortable coloration for the features
onstage.
 Lighting contrast: The audience area was dimly lit.
The stage was lightly lit. This transition was comfort-
able.
Overall Impression: The audience area needed more
light for necessary worksurface usage.  The color of
the stage lighting was very distracting and uncomfort-
able.  The transition of view from stage to worksurface
was comfortable.
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Setting 3: Video Conferencing

Quantitative criteria

Lighting levels within this setting are indicated in Appendix
C.3.   A diagram (Figure 3.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 3.3) was completed at this setting.
Its results indicate that the light levels are minimal throughout
the visual field.  The primary focus is on the slide projection
screen used for video conferencing and indicates a high level
of contrast between screen illumination and the rest of the
visual field.  Lower levels of lighting range from 0fc to 5.9fc.
Higher levels of lighting indicate a reading of 12.9fc, but im-
proper re-lamping may have occurred in the specific region
of the visual field.  This observation was made as a result of
non-uniformity light levels within the reflected ceiling mounted
stage lights.

Page 25

Figure 3.4  Lighting Levels Diagram, Setting Three: Video Conferencing



VITAL SIGNS VI: A Lighting Study of the Walter Byers Auditorium at the NCAA Headquarters, Indianapolis, Indiana
Center for Energy Research/ Education/Service (CERES), Ball State University, Muncie, Indiana, Fall Semester 2001
B. Garrett, F. Grunert, S. Karwan

Setting 4: House Lights

This setting seemed to be incorrectly indicated as the term
�house lights� usually refers to a fully-lit atmosphere.  Instead,
in this setting there was no lighting in the seating area, and
the stage was essentially completely lit. The plan diagram
(Figure 4.1) indicates each fixture status within the space.

Figure 4.1 Setting Four: House Lights, Fixture Status Diagram
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Setting 4: House Lights

Figure 4.3  Visual field map, Setting Four: House LightsFigure 4.2 Setting Four: House Lights
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Setting 4: House Lights

Qualitative criteria

An analysis of the qualitative criteria indicates few minor prob-
lems.

Glare:  Non-existent to minimal.
Worksurface glare:  Glare was non-existent.  Lighting
was inappropriate for worksurface usage.
Shadows:  Shadows are present only in areas to the
right and left of center stage.  This is not distracting and
helps to highlight center stage, which is the desired
focus for this setting.
Worksurface shadows: Shadows are minimal.  The
general seating lights are not used, but the stage lights
produced shadows that were not distracting.
Backlighting:  Backlighting was appropriate and com-
fortable.  Dimmed backlighting combined with heavy
lighting of the lectern allowed the lectern to visually stand
out.
Lighting color: The stage lighting, combined with the
laminate surfaces of the stage walls, produced a yel-
low-orange light.  This coloration was not distracting or
uncomfortable.
Lighting contrast:  The stage and lectern are strongly
lit, and the audience area was weakly lit.  It produced
slight discomfort.
Overall Impression: The stage seemed too bright in
comparison to the audience, although the stage light-
ing provided the only light available for notetaking.
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Setting 4: House Lights

Quantitative criteria

Lighting levels within this setting are indicated in Appendix
C.4.   A diagram (Figure 4.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 4.3) was completed at this setting.
Its results indicate that lighting levels were minimal to general
audience areas and have a focus of maximum output levels
for stage and lectern applications.  Lighting levels, on stage
surfaces, indicate a range of 2.9fc to 18.3fc (finished floor of
stage level.  The maximum lighting level has a reading of
27.0fc and was taken at the top region of the lectern.  Light-
ing levels reflected toward general audience seating are fo-
cused to front-right and has a reading of 5.9.  Therefore, gen-
eral audience seating has no means of uniform lighting out-
put.

Figure 4.4  Lighting Levels Diagram, Setting Four: House Lights
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Setting 5: Stage Left - Lecture

Figure 5.1 Setting Five: Stage Left - Lecture, Fixture Status Diagram

This setting was a specialized setting establishing a neces-
sary placement of the lectern.  Its atmosphere was appropri-
ate for lectures as it highlighted activities onstage and al-
lowed for note taking in the seating area. The plan diagram
(Figure 5.1) indicates each fixture status within the space.
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Setting 5: Stage Left - Lecture

Figure 5.3  Visual field map, Setting Five: Stage Left - LectureFigure 5.2 Stage Five: Stage Left - Lecture
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Setting 5: Stage Left - Lecture

Qualitative criteria

An analysis of the qualitative criteria indicates few minor prob-
lems.

Glare: Non-existent.  Space was uniformly lit through-
out eliminating the existence of glare.
Worksurface glare:  Glare was minimal.  Worksurfaces
were lit uniformly and appropriately lit for note taking.
Only glare present was due to material quality of
worksurface, but was not distracting.
Shadows:  Shadows were minimal.  Lighting of stage
bulkhead produced shadow on rear wall of stage.
Worksurface shadows:  Shadows are heavy due to
multiple overhead fixtures.  These geometries created
multiple shadows from seated persons that are very dis-
tracting.
Backlighting:  Backlighting was successful.  The lecturn
was appropriately backlit on stage that seemed to high-
light the area of focus.
Lighting color:  Lighting color was very appropriate.  It
was comfortable at the worksurface, not yellow or or-
ange due to minimal overhead stage lights.
Lighting contrast:  Stage seemed unbalanced.  At the
lecturn it was very well lit but contrasted deeply with the
virtually unlit opposite side of the stage.
Overall Impression:  The overall space was excellent
except for the contrast from stage right to stage left.
Stage right and stage left could be balanced a bit more
to lessen the visual contrast.  However, the transition
from the audience to the stage was very successful and
did not seem to cause contrast.
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Setting 5: Stage Left - Lecture

Figure 5.4  Lighting Levels Diagram, Setting Five: Stage Left - Lecture

Lighting levels within this setting are indicated in Appendix
C.5.   A diagram (Figure 5.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

 A visual field map (Figure 5.3) was completed at this setting.
Its results indicate that lighting levels are minimal throughout
the visual field.  Lighting is uniform and illuminates all task
surfaces within the general seating areas with readings be-
tween 2.3fc and 2.9fc.  The lighting levels are at its maximum
potential on stage left of the visual field with readings ranging
from 3.2fc (wall surface) to 11.3fc (stage finished floor sur-
face).  Lighting levels from reflected ceiling surface are mini-
mal to none with a maximum reading of 2.5fc.
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Setting 6: Stage Right - Lecture

Figure 6.1 Setting Six: Stage Right - Lecture, Fixture Status Diagram

This setting was a specialized setting establishing a neces-
sary placement of the lectern.  Its atmosphere was appropri-
ate for lectures as it highlighted activities onstage and al-
lowed for note taking in the seating area. The plan diagram
(Figure 6.1) indicates each fixture status within the space.
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Setting 6: Stage Right - Lecture

Figure 6.3  Visual field map, Setting Six: Stage Right - LectureFigure 6.2 Setting Six:  Stage Right - Lecture
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Setting 6: Stage Right - Lecture

Qualitative criteria

An analysis of the qualitative criteria indicates few minor prob-
lems.

Glare:  The space contained highly lit center lights that
produced some overall glare, however, it wasn�t within
the visual image.
Worksurface glare:  Worksurface glare was non-exis-
tent.
Shadows:  Shadows were present within the ceiling
grids, however they were not distracting.  They actually
added to the spatial feel giving some accent to its depth.
Worksurface shadows:  Contained multiple shadows
from the many overhead lights.  This was not distract-
ing however.
Backlighting:  Backlighting was present on rear of
stage and was adequate; however, lectern was not ac-
centuated as much as it could have been.
Lighting color:  The lighting color was a yellowish gray
in the audience area.  This was comfortable for detailed
note taking.  The stage was a yellowish yet was com-
fortable.
Lighting contrast:  The stage from right to left dimmed
yet was well-lit and comfortable on eyesight.  It pro-
vided a focal point at the stage and blended into the
audience very well enhancing visual comfort in the audi-
ence.
Overall Impressions:  The setting was very comfort-
able.  Stage right to left was much more comfortable
than previous settings.  However, the lectern should be
brightened up a bit but the audience lighting was appro-
priate.

Page 36



VITAL SIGNS VI: A Lighting Study of the Walter Byers Auditorium at the NCAA Headquarters, Indianapolis, Indiana
Center for Energy Research/ Education/Service (CERES), Ball State University, Muncie, Indiana, Fall Semester 2001
B. Garrett, F. Grunert, S. Karwan

Setting 6: Stage Right - Lecture

Quantitative criteria

Lighting levels within this setting are indicated in Appendix
C.6.   A diagram (Figure 6.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 6.3) was completed at this setting.
Its results indicate that lighting levels are minimal throughout
the space.  Lighting is uniform on general audience, task sur-
face, areas with a focus to the center of all rows instead of a
uniform spread throughout.  Readings indicate levels between
.7fc and .8fc.  The lighting levels are at its maximum potential
on stage right of the visual field with readings ranging from
1.7fc (wall surface) to 6.3fc (stage finished floor surface).  The
majority of the lighting for stage right is focused behind the
lectern providing lower levels of contrast throughout the space.
Lighting levels from reflected ceiling surface are minimal but
increased compared to stage left setting and have readings
ranging from .6fc (dimming stage lights) and 60.0fc (center
general audience lights).
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Setting 7: Stage Center - Lecture

Figure 7.1 Setting Seven: Stage Center - Lecture, Fixture Status Diagram

This setting was a specialized setting establishing a neces-
sary placement of the lectern.  Its atmosphere was appropri-
ate for lectures as it highlighted activities onstage and al-
lowed for note taking in the seating area. The plan diagram
(Figure 7.1) indicates each fixture status within the space.
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Setting 7: Stage Center - Lecture

Figure 7.3  Visual field map, Setting Seven: Stage Center - LectureFigure 7.2 Setting Seven:  Stage Center - Lecture
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Setting 7: Stage Center - Lecture

Qualitative criteria

An analysis of the qualitative criteria indicates few minor prob-
lems.

Glare:  Minimal (at stage).
Worksurface glare:  Worksurface glare was minimal
and not discomforting.
Shadows: The stage bulkhead created shadows, yet
were minimal and not discomforting.
Worksurface shadows:  Worksurface shadows were
again multiple due to the many overhead lights.  This
created a slight discomfort in note taking.
Backlighting:  Stage was appropriately backlit, which
highlighted the stage center.
Lighting color:  The stage lighting was direct and not
bouncing off the laminate of the wing walls, and there-
fore was white while the audience lighting was yellow-
ish.  This contrast made it slightly uncomfortable since
you eye picked up on the visual change.
Lighting contrast:  Overall it was centrally lit, dimly lit
on the right and left and blended into the audience slowly.
This allowed the contrast to be very minimal and was
very comfortable for the visual field.
Overall Impression:  The setting was very comfort-
able.  The low contrast of overall stage lighting and au-
dience lighting was very appropriate and was very com-
forting on the eyes.  The setting allowed for individuals
to adjust quickly and easily from the worksurface to the
stage setting.
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Setting 7: Stage Center - Lecture

Figure 7.4  Lighting Levels Diagram, Setting Seven: Stage Center - Lecture

Quantitative criteria

Lighting levels within this setting are indicated in Appendix
C.7.   A diagram (Figure 7.4) depicts the general light levels
within the room.  The darker areas indicate the areas of lower
light levels within the setting; the lighter areas indicate areas
of higher light levels within the setting.

A visual field map (Figure 7.3) was completed at this setting.
Its results indicate that the lighting levels are minimal and have
a uniform spread to general audience, task surface, areas of
the visual field.  Readings indicate levels ranging from 1.6fc
to 2.8fc.  Lighting levels are at its maximum potential at stage
center and have readings ranging from 2.5fc (wall surface) to
20.3fc (stage finished floor surface).  Lighting levels from re-
flected ceiling surface are minimal with readings ranging from
0.2fc to 1.4fc.  Lectern surface indicates a maximum reading
of 7.8fc indicating a lamp used for task lighting applications.
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Diagnostic

The findings of our study prove our hypothesis.  The Walter
Byers Auditorium is appropriately lit for seven different uses.
The problems discovered are minimal and do not distract
from any of the functions of the space.  The system provides
appropriate lighting conditions for lectures, video-
conferencing, slide projections, and many other typical uses.
The system allows for manipulation as the space changes,
or if more functions are added to the space.

However, the lighting system could be enhanced. Some sug-
gestions to provide better lighting conditions for the space
include:

-A new labeling for the preset lighting system�s settings.
While the lighting system provided necessary settings
to accommodate for a variety of uses, these setting did
not necessarily correspond to the apparent titles.

-A proactive approach to relamping.
Problems with burnt-out lamps were the most apparent
problem and disturbed the lighting quality of the space.
Some luminaries had not been replaced; others had
been replaced with lamps that did not correspond to the
other lamps, and did not correspond with the lighting
design specifications.

-The finishes of the stage, in particular, could be changed to
lessen glare and to create a more comfortable coloration of
light.

The laminate wall finishes produced a discomforting
yellow-orange light in some settings.  It also produced
some amount of glare; a new matte finish could be se-
lected to address issues of glare and coloration.

-The finish of the worksurfaces in the audience could be a
matte finish.

The issues of worksurface glare were minimal yet the
laminate at the worksurface produces much more glare
than desired.  The laminate should have more of a matte
finish to reduce the amount of reflective glare on its sur-
face.

-The presence of glare on the stage could be reduced to pro-
vide a more comfortable visual field.

The presence of glare from stage right to stage left on
many of the settings was visually uncomfortable.  The
progression of vision from bright spots to dark spots is
very drastic and could be handled in a more gradual
progression.
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Figure A.1a  Fixture FA

Figure A.1c  Fixture FC-1

Figure A.1b  Fixture FD

Figure A.1d  Fixture FK

Appendix A - Light Fixture Inventory

Figure A.1e Fixture FE
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Appendix A - Light Fixture Inventory
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Below is a list of specifications for the lighting fixtures used in
the Walter Byers Auditorium.

The FA fixtures (see Figure A.1a) are used for an assortment
of applications within the space and are the most common in
the lighting control program.  The FA fixtures are mounted in
ceiling for stage light applications and use incandescent spot
lamps.  There are a set of three fixtures in each grouping and
three groups, each recessed in a coffer.  Within the seating
area, the FA lamps are mounted as a grouping of 4 units
within each bay having a centralized FE fixture (see descrip-
tion below) as the primary lamp of focus.  These FA fixtures
are equipped with 100-watt incandescent spot lamps and
have an illuminance level adjustment controlled by the preset
functions.  The FA lamps are mounted in the ceiling of the
control room and vestibules.

The FD units (see Figure A.1b) were used for the illumination
of the projection screen and its wall surface at the rear of the
stage and help reduce distracting reflections that may occur
on the surface. Three fixtures (of six, four and six lamps) were
used in a single row.

FC units (see Figure A.1c) are installed between the first and
second row of coffers from stage front to accent stage light-
ing during all control settings.  These fixtures are installed in
sets of three and grouped into three separate areas resulting
in one row of 9 fixtures.  The two outside fixtures are equipped

with 90-watt incandescent flood lamps and the other 7 fix-
tures are equipped with 250-watt incandescent spot lamps.
FC-1 units are similar to the FC units but are mounted at a
45-degree angle  (within a sloped bulkhead) to illuminate the
stage.  The lamps in the fixture are parallel to the floor, al-
though the fixture itself is sloped.  This allows for direct illumi-
nation to the finished floor and worksurfaces on stage.

The FK units (see Figure A.1d) were used along the two side
aisles leading down to side stage.  The units are mounted 2�-
0� above the finished floor to illuminate and accent the walk-
ways on both sides of the seating area and remain at a con-
stant level of illumination during all cycles of the control set-
tings.   These fixtures were not studied as they were always
on but never in the visual field.

The FE lamps (see Figure A.1e) are the centralized lamps of
each coffer in the seating area of the auditorium.  There are a
total of twelve fixtures which house an incandescent cool light
lamp that provides a diversity of illumination levels based on
the preset controls. Insufficient records were kept by the
facility�s management to detail these any further.

For additional information on described fixtures, see reflected
ceiling plan for placement and labeling of lamp types.
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Appendix B - Visual Field Map Production Procedure

Vital Signs
11 October 2001

Rough Outline of Image manipulation procedure

Photograph desired scene(s).

In Photoshop 5.0:
1. File -> Open �file.jpg�
2. File -> Save as �bas.psd�
3. Image -> Mode -> Indexed Color

Palette � adaptive, colors-8?, dithering- none
4. Image -> Mode -> Greyscale
5. Filter -> Artistic -> Cutout (optional? � must have 8 or less colors)

Levels- same as number of colors above, edge simplicity-5,
edge fidelity-3

6. Image -> Adjust -> Levels (optional � can adjust to use full black-
white ranges)

7. File -> Save as �tones.psd�
8. Filter -> Stylize -> Find edges
9. File -> Save as �edges.psd�

Print both tones and edges and go take luminance measurements.
Record measurements on edges printout.

Back in Photoshop 5.0
10. File -> Open �tones.psd� and �edges.psd�

In �edges.psd�
11. Select -> Color Range�

Select � highlights, image, invert
12. Edit -> Copy

In �tones.psd�
13. Edit -> Paste
14. Close �edges.psd�
15. Add text layers (may need to render then merge text layers as you

go)
16. Confirm text visibility
17. File -> Save as �final.psd� (can go back to this one for editing)
18. Delete layers as needed to achieve desired appearance.
19. Layers -> Flatten Image
20. Save as �final.jpg� .tif?, .gif? (this one is for inclusion in publica-

tion)
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Appendix C - Data Collections (Footcandles)

Figure C.1 Setting One:Full Stage Figure C.2 Setting Two:Slide Projection
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Appendix C - Data Collections (Footcandles)

Figure C.3 Setting Three: Video Conferencing Figure C.4 Setting Four: House  Lights
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Appendix C - Data Collections (Footcandles)

Figure C.5 Setting Five:Stage Left - Lecture Figure C.6 Setting Six:Stage Right - Lecture
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Appendix C - Data Collections (Footcandles)

Figure C.7 Setting Seven: Stage Center - Lecture
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